
What is Power Defrag? 
What is Power Defrag?
Power Defrag is a utility designed to make common system maintenance tasks faster and easier.

Power Defrag operations are faster than regular system maintenance tasks because Power Defrag runs the standard
Microsoft Windows system utilities in a highly optimised environment. Because most other functions on your PC are 
disabled in this environment, there are fewer external applications writing to disk or using up your valuable system 
memory while these programs run.

Power Defrag is easier to use than the standard system maintenance tools because all important functions are 
grouped together in one application, allowing the user to select those operations which are best suited to the 
moment. Power Defrag also supports scheduling, allowing tasks to be completed without user intervention during 
times when you will not be using your PC.



Will it run on my machine? 
Will it run on my machine?
Power Defrag 3.00 runs on Windows 95, Windows 98, Windows 98 SE, Windows ME and Windows XP.

At this stage there is no support for Windows 2000 although this functionality has been planed and will be included in 
a future version of the product,

Power Defrag will behave slightly differently on each of these platforms due to minor evolutionary changes to the 
Microsoft Windows operating system. All of these variations are described under the Power Defrag Tasks section of 
this help file.



How do I use it? 
How do I use it?
Power Defrag is designed for ease of use by virtually any level of computer user. You do not need to be a technical 
expert to benefit from its efficiency and the collection of system tools which it accessed.

In order to perform basic Power Defrag functions, simply select the tasks which you wish to perform in the left hand 
section of the screen. Once your selection is complete, press the button marked "begin" on the lower right hand side 
of the screen. Although you may be called upon to enter your username and password, you will not need to do 
anything else. Power Defrag will organise the tasks which you have selected into the optimal order and execute them 
using the default settings, or the settings which you have chosen if you are an advanced user.

More details of the tasks which you can choose are available in the next section of this help file. A complete 
description of all the advanced options is included.



Changing views 
Changing views
If you are a non technical computer user or are new to system maintenance tasks, you may want to retain the 
Beginner View option which is the default Power Defrag view.

More advanced users may want to work with the Advanced View, which lists all available task options. These options 
can easily be changed simply by switching to the Options View.

Power users may want to work with the Options View all of the time.

There are two ways of changing between views. Either use the View menu, which contains all three options, or use 
the 3rd, 4th and 5th buttons on the toolbar.



What is new in Power Defrag 3? 
What is new in Power Defrag 3?
Every this in Power Defrag 3, to a greater or lesser extent, is new. Every component has been rewritten for improved 
efficiency and greater reliability. Only some secondary support code has been modified rather than written from 
scratch.

While the interface is clearly new, the greatest changes actually occur in the way in which Power Defrag enhances 
the operation of the Microsoft Windows system tools.

In version 2, only the programs which stared with the system shell were disabled. In version 3, all Windows services 
are disabled too. This means vastly improved defragmentation and ScanDisk operations for Windows 9x users.

For the first time, Power Defrag support has been extended to the Windows NT based family of operating systems. 
Presently, this support only exists for Windows XP. We will be expanding Power Defrag's functionality in the future to 
include Windows 2000.

Power Defrag 3 also supports unattended operation and the ability to load and save commonly used configurations.



Basic Power Defrag options 
Basic Power Defrag options
Return to Basic View at next startup
This option will cause Power Defrag to start up showing the Basic or Beginner's version of this document every time 
you run the program.
Default: Off
Available on all platforms

Return to default screen position at next startup
This option will force the Power Defrag window to open in its original screen position every time you run the software.
Default: Off
Available on all platforms

Return to default size at next startup
This option forces Power Defrag to open with its original window dimensions every time you run the software.
Default: Off
Available on all platforms

Return to default options at next startup
This option will reset all of these options to their default setting once. Clearly, when this is done, this option is disabled
again and your future options will be saved as usual.
Default: Off
Available on all platforms

Restart after all operations (For Zone Alarm users)
Under Windows 95, 98 and ME, Power Defrag's startup routine is not compatible with the Zone Alarm personal 
firewall program and may not be compatible with other firewall programs either. If you experience problems accessing
your network after running Power Defrag 3.00, select this option. The machine will restart in its standard configuration
after all Power Defrag operations are complete and no further problems should occur.
Default: Off
Available on Windows 95, 98 and ME

Shut down after all operations
This option will shut your computer down after all Power Defrag options are complete.
Default: Off
Available on all platforms



Power Defrag Tasks 
Power Defrag tasks
The Power Defrag functions are arranged in four sections.

· Defragmentation
· Error Check
· Surface Scan
· System Tools

These can be seen on the left hand side of your Power Defrag window.

Although the exact functionality of each section differs in accordance with the operating system which you are 
running, the basic principles remain constant across all platforms.



What is defragmentation? 
What is defragmentation?
Defragmentation is a kind of drive optimisation which should regularly be performed on your computer system.

As you work with files on your disk drives, they become fragmented. This means that the individual chunks of data 
which make up the files are no longer stored together but become mixed up with the other chunks which make up 
other files.

Windows is perfectly capable of sorting these file fragments out so that, when you open a file on your machine, the 
correct chunks of data are assembled in the correct order, but this process takes time.

Defragmenting your drive reduces the amount of extra work your computer needs to perform in order to access a file 
and will speed up certain operations.

If your hard disk drive becomes extremely fragmented, your machine may appear to be very slow. Sometimes 
information can also be lost due to the complexity involved in sorting out the chunks of data when working with files. 
For this reason, we recommend that you defragment your drives at least once a month, even if you are not 
experiencing any problems.



How does this work? 
How does defragmentation work?
Power Defrag uses the Microsoft Disk Defragmenter to perform this optimisation on your hard drives.

Under Windows 95, Windows 98 and Windows ME, the normal disk defragmenter is called once Power Defrag has 
set up the optimised environment. This program may look familiar to you although it will probably run significantly 
faster than when you run it in the standard Microsoft Windows environment.

Under Windows XP, a command line version of the disk defragmenter will be called. This gives far better performance
than the standard defragmentation tool and also runs in an optimised environment, resulting in even better 
performance.



Defragmentation options 
Defragmentation options
Check the drive for errors before defragmenting
This option forces the Microsoft defragmentation tool to check the drive for errors before defragmenting the drive. 
This is a very worth while safety precaution because defragmenting a drive which contains errors can result in data 
loss. Sometimes, however, this check causes your computer to lock up. If your machine crashes when 
defragmentation starts, turn this option off.
Default: On
Available on Windows 95, 98 and ME

Defragment files and not free space
The Microsoft defragmentation tool offers several levels of defragmentation. You can defragment files only or you can
defragment files and free space, which is the default. Although it is faster to defragment only files, the result is not 
very good and the rate at which fragmentation occurs increases greatly. If you are in desperate need of a fast, partial 
defragmentation, turn this option on. We do not recommend this as a permanent setting.
Default: Off
Available on Windows 95, 98 and ME

Show detailed output
The Windows XP defragmentation tool has two output modes. One displays only minimal information about the drive 
which is being defragmented and the other gives details of the degree of fragmentation, number of allocated clusters 
and similar technical information. We have elected to display this detailed output by default for no reason other than 
the fact that the summarised documentation is very uninteresting.
Default: On
Available on Windows XP



What is the error check? 
What is the error check?
This function will use the Microsoft disk checking utility to examine your hard disk drive for errors in the filing or 
indexing systems.

The type of check which will be performed is known as a "standard" check and it can fix problems before you even 
notice them.

This check is very import because an uncorrected error can spread through your data and result in the loss of all the 
files on your computer in the worst cases.

We recommend that you check you drives for errors at least once a week.



How does error checking work? 
How does error checking work?
Under Windows 95, Windows 98 and Windows ME, Power Defrag will call ScanDisk, the Microsoft Windows disk 
checking tool. Although this tool may look familiar, it will probably run far faster under Power Defrag than it usually 
does. It will also restart a lot less often.

Under Windows XP, Power Defrag will use the ChkDsk family of tools to perform the check. Because of the 
architecture of Windows XP, it is most efficient to check drives for errors during the start-up process. Power Defrag 
configures Windows XP to run the initialisation time disk checking tools which would normally only run if an error were
to be detected on your drive. Operation will occur just after Power Defrag has restarted your machine and will appear 
as white text on a blue background.



Error checking options 
Error checking options
Check the host drive for errors first
On Windows 9x machines with DriveSpace compressed volumes, the Microsoft ScanDisk tool allows you the option 
to check the "host", or real drive, for errors before you check the virtual compressed drive. We have elected to keep 
this option on by default because it is not clear why anyone would want to disable it.
Default: On
Available on Windows 95, 98 and ME

Report MS-DOS mode name length errors
The long file name system used by Microsoft Windows has a different maximum path length limitation from the file 
system used by MS-DOS. This means that if you start your computer in MS-DOS mode, some files may not be 
accessible at all if they are stored in deeply nested directories because it is impossible to enter their path on the 
command line on account of its length. ScanDisk can report this "problem" but it is better to disable this option as a 
typical hard disk drive contains a lot of files that will trigger the message. Enabling this option can result in enormous 
ScanDisk log files.
Default: Off
Available on Windows 95, 98 and ME



What is surface scan? 
What is surface scan?
This function with use the Microsoft disk checking utility to examine the surface of your hard disk drive. If it finds any 
problem areas, it will mark them as "bad" and prevent data from being written to them. This can protect you from 
serious data loss.

This type of check is usually described as a "thorough" check. It includes a "standard" check which will verify the 
integrity of your file system.

This check is very import because an uncorrected error can spread through your data and result in the loss of all the 
files on your computer in the worst cases.

If there are surface defects on your hard disk drive, you stand to lose data permanently. In some cases, you will have 
to replace your hard drive.

We recommend that you perform a surface scan on your drives at least once a month.



How does surface scanning work? 
How does surface scanning work?
Under Windows 95, Windows 98 and Windows ME, Power Defrag will call ScanDisk, the Microsoft Windows disk 
checking tool. Although this tool may look familiar, it will probably run far faster under Power Defrag than it usually 
does. It will also restart a lot less often.

Under Windows XP, Power Defrag will use the ChkDsk family of tools to perform the check. Because of the 
architecture of Windows XP, it is most efficient to check drives for errors during the start-up process. Power Defrag 
configures Windows XP to run the initialisation time disk checking tools which would normally only run if an error were
to be detected on your drive. Operation will occur just after Power Defrag has restarted your machine and will appear 
as white text on a blue background.

In both these cases, the Surface Scan will call the disk checking tool using the thorough option. This causes the 
Windows tool to examine the entire surface of your drive for flaws in the disk medium and can take a long time.



Surface scanning options 
Surface scanning options
Check the host drive for errors first
On Windows 9x machines with DriveSpace compressed volumes, the Microsoft ScanDisk tool allows you the option 
to check the "host", or real drive, for errors before you check the virtual compressed drive. We have elected to keep 
this option on by default because it is not clear why anyone would want to disable it.
Default: On
Available on Windows 95, 98 and ME

Report MS-DOS mode name length errors
The long file name system used by Microsoft Windows has a different maximum path length limitation from the file 
system used by MS-DOS. This means that if you start your computer in MS-DOS mode, some files may not be 
accessible at all if they are stored in deeply nested directories because it is impossible to enter their path on the 
command line on account of its length. ScanDisk can report this "problem" but it is better to disable this option as a 
typical hard disk drive contains a lot of files that will trigger the message. Enabling this option can result in enormous 
ScanDisk log files.
Default: Off
Available on Windows 95, 98 and ME



What are the system tools? 
What are the system tools?
The functions in this section of Power Defrag 3.00 allow you to secure vital parts of your Windows operating system.

Under Windows XP, you can set a system restore point. Although Windows will do this by itself every so often, it is 
useful to be able to create one at will.

Under Windows 95 and 98, these functions are oriented around backing your registry up and keeping it in good 
repair.

We recommend using these backup functions before you install any new software packages or reconfigure your 
system. The backups can be restored using the functions on the Tools menu of Power Defrag 3.00.



Loading and saving 
Loading and saving
Power Defrag 3 allows you to create Power Defrag batch files. These files contain custom selections of tasks and 
their accompanying options.

In order to create a Power Defrag batch file, simply make your selections and then select Save from the File menu, or
the second button on the tool bar. The currently selected settings will be saved to disk and the file name will be 
reflected in the status bar, on the bottom left hand side of the Power Defrag window.

The first button on the tool bar, or the Load option on the File menu, can be used to retrieve these settings from disk.

Using these features, you could create a batch for your monthly maintenance tasks and another for your weekly 
maintenance tasks. These could be loaded at the click of a button and executed by pressing the Begin button.



Automating operation 
Automating operation
Due to overwhelming customer demand, we have implemented an unattended mode of operation in Power Defrag 3. 
This is designed for the more technical user who wants to use the Microsoft System Agent to run Power Defrag or 
wants quick access to predefined features.

The command line parameters are as follows:

Pdefrag [/AUTO] [filename.pdb]

"/AUTO" is an optional parameter which prevents Power Defrag from showing any confirmation dialogs when it 
operates. There is no need to press the begin button either. Power Defrag will start executing the selected tasks as 
soon as it has loaded up.

It should be noted that this parameter is only useful once Power Defrag 3 is registered, since the unregistered 
version's welcome message will always require user intervention.

"filename.pdb" is an optional parameter indicating the Power Defrag batch file which should be loaded and executed. 
This results in automatic execution is used with the /AUTO parameter. If no file is specified, Power Defrag will always 
load up the last configuration which was selected.

Very importantly, these command line options cannot automate Power Defrag completely. Because the Power Defrag
process involved restarting the machine, you will most probably be required to enter a username and password at 
least once during the operations. This brings us to the very important point of the Auto Login function, discussed in 
the next section.



Windows 9x Auto Login 
Windows 9x Auto Login
Under Windows 95, 98 and ME, the Auto Login function, accessible on the Tools menu in the Options section, can be 
used to avoid having to enter a username and password the first time the machine restarts under the control of Power
Defrag.

The excellent Microsoft utility, TweakUI, cannot be used for this purpose because it runs as a service and Power 
Defrag 3 temporarily disables services under Windows 9x because they impede the efficiency of the Power Defrag 
operations.

The Windows 9x Auto Login feature will only work once. This is because it disables the network functions of 
Windows. If the Auto Login feature is enabled, the machine will automatically restart after the Power Defrag 
operations have completed. This process will end at the normal Windows login screen. The user will be required to 
enter their username and password in order to restore network connections. If TweakUI us being used to automate 
the login process, it will be enabled at this point and the system will start up in the way that it usually does.



Windows XP Auto Login 
Windows XP Auto Login
Under Windows XP, the Power Defrag Auto Login function, which can be accessed in the Options section of the Tools
menu, performs a complete system login. Space is provided in the options dialog box for a username and password 
to be entered. These are used to access the machine and they should reflect an account with administrative access 
in order for the defragmentation to work.

This process occurs only once, as a security precaution.

We do not recommend the use of this feature in a secure environment. There are very serious security issues
which can result from these settings and these are discussed separately in this help file.



Windows 9x tools 
Windows 9x tools
The Windows 9x computing platform evolved over half a decade to include various releases of the Windows 
operating system. Usually, these different versions are pretty similar. In issues of system maintenance, however, they 
vary greatly, resulting in different menu options for different operating systems. These are summarised here.

Windows 95
Because Windows 95 includes no native registry backup and restore tool, Power Defrag 3 includes a custom 
mechanism which allows you to make backup copies of the registry files. This function is shown under System Tools 
in the Power Defrag Tasks on the left had side of the power Defrag window.

These registry files can be restored from the tools menu. In addition, since the registry backups can be rather large, 
we have included a facility for users to delete old registry backup files which they no longer require. Depending on 
available hard drive space, we would not recommend keeping more than five back up registry files. Just these five 
may take up as much as 50Mb of disk space on older Windows systems with many installed applications.

Windows 98
With Windows 98, Microsoft introduced the ScanReg tool which supports several useful registry functions. Two of 
these functions are represented on the tools menu.

The option to repair the registry will rebuild your registry files, removing any unused space and correcting any errors 
which may be disrupting the integrity of your registry files. It is important to note that we have encountered machines 
on which this function will cause the entire system to hang. This is a result of an irrecoverable error and is not related 
to Power Defrag itself, although Power Defrag 3 will recover gracefully from this problem after the machine is reset.

There is also an option to restore a previously backed up registry file. ScanReg itself will ensure that only the most 
recent five registry backups are stored on your drive.

Both of these tools require that the machine is restarted. They will then operate in an MS-DOS based mode, 
appearing as while and yellow text on a blue background.

Windows ME
Windows ME introduced a completely graphical registry maintenance tool which duplicates the function of the MS-
DOS based ScanReg found in Windows 98. The repair and restore functions listed in the tools menu both require the 
machine to be restarted.



Windows XP tools 
Windows XP tools
Because the Windows XP System tools revolve around the System Restore function which is built into the XP 
operating system, the Tools menu offers the ability to open the System Restore program as well as providing an 
additional method of creating a system restore point.



Log files 
Log files
With a few exceptions, such as the Windows XP disk checks, Power Defrag will automatically log all activities which it
performs. There files are stored on your hard drive and deleted over time in accordance with the settings which the 
user specifies in the Options section of the Tools menu.

The log files can be accessed via the View logs menu item, also in the Tools menu.

Each file contains a detailed list of the activities which were performed as well as how long each took to run to 
completion.



Trivial functions 
Trivial functions
Aside from the Auto Login feature, which should be used with caution, the Options section of the Tools menu contains
the following features.

Log file settings
It is possible for the user to limit the number of log files which are stored on the machine's hard disk drive or the 
duration for which they are stored. These options are presented here. By default, 15 of these files are stored at any 
one time.

Windows XP Disk Checking Time Delay
This option is only enabled under Windows XP. Because Power Defrag uses the pre-start-up disk checking utility on 
this platform, it is subject to the start-up protocol of the operating system itself. This means that before each of the 
disk check operations are performed, Windows XP warns the users and allows them, by default, a 10 second time 
period in which to cancel the check.

This is a very useful function because full surface scan operations can take a very long time but, to an equal extent, 
makes no sense in an application geared towards reducing the amount of time which these operations take. For this 
reason, we have created a facility which allows the user to alter the amount of time for which the system waits before 
initiating the disk checks. This can be set to anything from zero to 10 seconds, depending on the confidence of the 
user.



SECURITY 
SECURITY
Under Windows XP, the use of the Auto Login function has very serious security implications and can compromise a 
system or group of systems if used imprudently.

We do not recommend the use of the Auto Login function under Windows XP in any form of secure 
environment.

Auto Login uses the standard Microsoft supplied mechanism which has been available since Windows NT was 
introduced. As a by product of this mechanism, the username and password of the account used to gain access to 
the machine automatically is saved in the system registry in unencrypted, plain text format.

This means that any user, malicious or otherwise, with access to the machine's system registry, locally or remotely, 
can read this username and password combination off their screens and gain access to the machine. Since Power 
Defrag requires this account to have administrative privileges, it is possible for someone to take complete control of 
your machine.

If you are unsure about anything which we have stated in this section, it would be advisable to avoid using 
the Auto Login feature under Windows XP.



Zone Alarm on Windows 9x 
Zone Alarm on Windows 9x
Windows 9x users who are running the excellent ZoneAlarm personal firewall product from ZoneLabs will notice that, 
after all Power Defrag operations are completed, their network connections will not be accessible.

This is because of the interaction between the ZoneAlarm service and the Windows 9x login process. Because Power
Defrag delays the loading of services, the ZoneAlarm product cannot hook into the login function as it would normally.

Power Defrag supports a specific feature which eliminates this problem. Users can turn it on by following these 
instructions:

1. Click on "Power Defrag Tools" in the left side of the screen. Make sure this section is highlighted.

2. Click on the View menu and select Options.

3. Click on the check box which is labelled, "Restart after all operations (For Zone Alarm users).

4. Click on the View menu again and select your desired default view.

This problem will only occur if you are not using the Auto Login function. Auto Login automatically restarts the 
machine once all operations are complete and this setting will have no effect.



Licensing model 
Licensing model
The Power Defrag 3 software package is distributed in the form of a 30 day trial version. Users who enjoy the 
software can purchase a registration key which will convert the trial package into a full version which will run in 
perpetuity.

Unlike Power Defrag 2, which used a Lite and a Pro model, there is only a very small reduction in functionality in the 
Power Defrag 3 trial software which involves command line automation.

There is no freeware version of Power Defrag 3. We will, however, keep the freeware Power Defrag 2.0 Lite 
packages available for download. From the release of Power Defrag 3, no further Power Defrag 2 licenses will be 
sold.

Power Defrag 3 registration keys retail for US$40.00. The customer should supply a desired Registered Name. From 
this, we will generate a Registration Key and send it to the customer by E-mail.

Existing owners of Power Defrag 2 Pro will be eligible to purchase an upgrade license for the cost of US$20.00. 
Customers making use of this upgrade offer must specify there Power Defrag 2.00 registration key in the order form. 
If this is not done, we will be unable to complete the order. Clearly, however, we will assist customers in finding their 
information whenever possible.

In total, the cost of purchasing Power Defrag 2.00 Pro and upgrading to Power Defrag 3.00 will be the same as 
purchasing a new copy of Power Defrag 3.00.

Like in the Power Defrag 2.xx product family, all future minor version number upgrades to future 3.xx products will be 
free to all registered users, although they will have to download these updates from out Web site themselves.

All registrations can be performed via the Power Defrag Web site, located at http://www.powerdefrag.com.



I purchased a registration. What now? 
I purchased a registration. What now?
Once you have purchased a Power Defrag 3 registration key, open the Power Defrag software, click on the Help 
menu and select the Register option. A dialog box will be opened which will allow you to enter your Registered Name 
and Registration Key.

Please take care during this process. Because the Registration Key is derived, through a cryptographic algorithm, 
from the Registered Name, spaces, punctuation and spelling are very important. The information which is entered 
must match, exactly, the information in the E-mail which contains your Registration Key.

Please follow the instructions included on the registration screen.

Once this registration is accepted, no more welcome screens will appear and your copy of Power Defrag 3 will no 
longer expire.

Please note that we reserve the right to cancel registrations in cases where the credit card transaction proved to be 
fraudulent or incomplete. In the case of a refund, the registration key will also be voided and its continued use will be 
a violation of the software license agreement. We also reserve the right to cancel registrations when compelled to do 
so by the statutory requirements of the territories from which we operate.



Support and service 
Support and service
If you have a comment or question about Power Defrag 3.00, please contact us using one of the following addresses.

All support issues relating to the trial version of the software should be addressed to support@e-technik.com. Your 
message will be answered as soon as possible.

Registered users will receive preferential support if they mail pdsupport@e-technik.com and quote their Registration 
Key in their message. We make every possible effort to respond to all of these messages within 1 working day.

If you have any questions about our other services or believe that we may be able to assist you with a customised 
solution, please send a message to service@e-technik.com.



About E-Technik 
About E-Technik
Power Defrag is a product of E-Technik Website Development (Pty) Ltd.

Located in the city of Port Elizabeth, South Africa, E-Technik specialises in the development of quality shareware 
products and Web based information solutions for the global market.

Please take the time to visit our Web site at http://www.e-technik.com.

If you liked Power Defrag, you may also be interested in our other utility suite, Power Launch. Power Launch allows 
you to create customised shortcuts on your system which allow you to perform multiple tasks with command. These 
can range from opening a set of your favourite Web pages to closing down your extra utility software in order to 
optimise your machine for game play.

Take a tour of the Power Launch features at http://www.powerlaunchcentral.com.

E-Technik is also involved in motor sport sponsorship and has recently partnered with an organisation dedicated to 
breaking the World Two Wheeled Land Speed Record and a location within South Africa. Find out about this exciting 
effort at http://www.speedrecordsa.co.za.



Software License Agreement 
Software License Agreement
By installing this software, you agree to the terms of the following Software License Agreement.

Power Defrag 3 remains the intellectual property of E-Technik Website Development (Pty) Ltd. Power Defrag 3 may 
not be disassembled, reverse engineered or analysed by any other means.

Power Defrag 3 may be redistributed at will provided such distribution occurs with neither a Registered Name nor a 
Registration Key. Without these items, the software will expire 30 days after installation and will no longer function. 
This 30 day period will be deemed a trial period for the purposes of the user ascertaining the suitability of the 
software to their needs. No attempt to prolong the trial period by any means other than the purchase of a registration, 
as manifested by a unique Registered Name and Registration Key combination, may be undertaken.

No Registered Name or Registration Key combination may be redistributed under any circumstances without the 
express written permission of E-Technik Website Development (Pty) Ltd.

Any violation of these limitations on distribution will be considered software piracy and the theft of intellectual property
and will be pursued to the maximum extent possible under law.

Power Defrag 3 is supplies as is. While every effort has been made to ensure that the software is of the highest 
quality, E-Technik Website Development (Pty) Ltd, its directors, staff, contractors and associated persons and legal 
entities accept no liability, express or implied, for any losses, direct or indirect, relating to the use of or the inability to 
use this software.

Because this software is made available on a trial basis for a period of 30 days, the purchase of a registration is 
deemed to be acknowledgement of the suitability of this software for the purposes of the user. E-Technik Website 
Development will consider no refunds of these purchases except where this policy is inapplicable due to statutory 
legislation or extreme circumstances.

Power Defrag is © E-Technik Website Development (Pty) Ltd. 2000, 2001, 2002. All other trade names mentioned in 
Power Defrag and its associated documentation remain the exclusive property of their respective owners.






